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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and
get a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
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cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le controleur.

e Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au controleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contrble électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

¢ WARNING: On outdoor operations, locations involving potential chemical
contamination or electrical interference, conditions or uses not described in this
document please contact Industrial Shields for further information.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.



Ref. 015001000400 Rev. 0: 26-08-2020

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: - Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
C us Certified to CSA Std. C22.2 No.61010-1
LISTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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NMDUSTRIAL SHIELDS

1 General Description M-DUINO 42 1/0s PLUS product

1.1  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and C the shield from above. Having a B and in the middle of them.

> ey S S P
.

| |
L

C ZONE
B ZONE
A ZONE

= 1 CZONE
1 || BZONE
" ocmiEia’ A ZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Outputs are hamed as Q1.X and relays as R1.X

12
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1.2 Zone Distribution

Communication

Y

Analog

Y

Digital

Rev. 0: 26-08-2020

ZONE C

Y

Analog

Y

Digital

The distribution of the different features that provide the M-Duino 42 I/Os PLUS is the

following one:

8 Outputs
(8 Digital Outputs,
3 of which can
work as Analog
Output)

Shield B Zone C Zone
12 Inputs 13 Inputs
(12 Digital inputs, 6 | (13 Digital inputs, 6
of which can work | of which can work
as Analog Input) as Analog Input)
Analog Shield

8 Outputs
(8 Digital Outputs,
3 of which can
work as Analog
Output)

13
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1.3

1.4

—

A Zone Features

Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) LoRa

Mechanical dimension

-

Rev. 0: 26-08-2020
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1.5 General Features

Rev. 0: 26-08-2020

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE B+C Zone
Fuse protection (2.5A)
Input Voltage 12:072:1Vdc Polarity protection
24 vd
Input rated voltage mc
Rated Power 30w
| max. 1.5A
Size 101x94.7x119.5
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

LoRa—12C — Ethernet Port — USB — RS485 —
RS232 — SPI — (2x) Rx, Tx (Arduino pins)

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in afinal
application

An/Dig Input 10bit
(0-10Vcce)

0to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Digital Isolated Input
(24Vcce)

5to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

* Interrupt isolated
Input HS (24vcce)

5to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcce)

0to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated
Output Relay

220V Vdc
| max: 5A
Galvanic Isolation
Diode protected for Relay

15
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PWM lIsolated Output
8bit (24vcce)

5to 24Vdc
max: 70 mA

Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Expandability

12C - 127 elements

- Serial Port RS232/RS485
LoRa

* By using this type of signal can no longer use Digital signal

(24vdc)

16
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2 Technical Specifications:

2.1

General Specifications:

Item

M-Duino PLC Arduino Ethernet & LoRa 42 I/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vdc ==

Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power
consumption DC power supply 30W max.
Power supply 2avde ===
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0°to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 490 g max.

17
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2.2

Performance Specification:

Rev. 0: 26-08-2020

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560
Flash Memory 256KB of which 8KB are used by the bootloader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz
2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet & LoRa 42 I/Os Analog/Digital PLUS:

Symbol Standard No. / Standard Symbol Meaning
Standard Title Reference No. /
Symbol Title
IEC 60417 / 5031 / Direct Indicates that the equipment is
] Graphical symbols Current suitable for direct current only;
EE = . for use on to identify relevant terminals
equipment
IEC 60417/ 5032 / Alternating | Indicates that the equipment is
Graphical symbols Current suitable for alternating current
for use on only; to identify relevant
N~ equipment terminals
IEC 60417 / 5130/ Pulse To identify the control by
Graphical symbols General which a pulse is started.
for use on
equipment
IEC 60417 / 5017 / Earth, To identify an earth (ground)
Graphical symbols Ground terminal in cases where
for use on neither the symbol 5018 nor
p— equipment 5019 is explicily required.
IEC 60417 / 5115/ Signal lamp To identify the switch by
Graphical symbols means of which the signal
for use on lamp(s) is (are) switched on or
equipment off.

18
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Medical Devices CE Marking CE marking indicates that a
Directive product complies with
93/42/EEC applicable European Union
regulations
ISO 7000/ 0434B/ Indicates a potentially
Graphical symbols | Warning symbol hazardous situation which, if
for use on not avoided, could result in
equipment death or serious injury
ISO 7000/ 5036 / Dangerous To indicate hazards arising
Graphical symbols Voltage from dangerous voltages
for use on
equipment

3 Precautions

Read this manual before attempting to use the M-Duino PLC Arduino Ethernet & LoRa 42 1/Os
Analog/Digital PLUS and follow its descriptions for reference during operation.

3.1  Arduino Board

The M-Duino 42 1/0s PLUS PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this

manual.

Before using M-Duino under different conditions from what has been specified in this manual

or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,

combustion systems, medical equipment, amusement machines, safety equipment and other

systems, machines, and equipment that may have a serious influence on lives and property if

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and

performance characteristics of M-Duino are sufficient for the systems, machines, and

equipment, and be sure to provide the systems, machines, and equipment double safety

mechanisms. This manual provides information for programming and operating the M-Duino.

19




Ref. 015001000400 Rev. 0: 26-08-2020

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings | Network

Shetchbool: location:

C:\Users\Albert\Documents\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size; 15

Interface scale: Automatic | 100 T %  (requires restart of Arduino)

Show verbose output during: [ compilation upload
Compiler warnings: None v

[Joisplay line numbers

[Jenable Code Folding

Verify code after upload

[Juse external editor

Checl: for updates on startup

Update sketch files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLS: htm:f/apps.\ndusw\alshle\ds‘cam/mam/ar’dumo,’boards,’pacl'age_\ndusw\a\sh\elds_\nde ﬁ
More preferences can be edited directly in the file
C\users\Albert\AppDataiLocal\Arduino1S\preferences. txt

(edit only when Arduino is not running)

OK Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

20
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4. Go to: Tools -> Board: ... -> Boards Manager

- _

@ sketch_aug20a | Arduino 189

File Edit Sketch Tools Help
Auto Format
Aschive Sketch

Fix Encoding & Reload

Manage Libraries. CtrieShiftel
| Serial Monitor CriShift+M
Serial Plotter Ctrl+Shift+L

WIFi101 / WIFININA Firmware Updater

Board: “M-Duino family” i
Model: “M-Duino 42+*

Boards Manager.

MSStack-FIRE

Get Board Info

Programmer: “Arduina Gemma®

Bum Bootloader

MSStick-C

ODROID ESP32
Heltec Wii Kit 32
Heltec WiFi LoRa 32

Heltec Wifi LoRa 32(v2)
Heltec Wireless Stick
ESPectro32
Microduino-CoreESP32
ALKS ESP32

WiPy 30

BPI-BIT

Silicognition wESP32
T-Beam

D-duino-32

LoPy

LoPy4

OROCA EduBot

ESP32 FM DevKit

Frog Board ESP32

Al Thinker ESP32-CAM
SparkFun LoRa Gateway 1-Channel

WiFi module

Ardbox family

Ardbox GPRS family
Ardbox WiFi/BT tamily
& M-Duino family
M-Duino GPRS family
M-Duino WiFi/BT family

5. Search for “industrialshields” on the browser.

Rev. 0: 26-08-2020

€ Boards Manager b¢
Type All ~ | industrialshields

industrialshields version 1.1.16 INSTALLED &

Boards included in this package:

ARDBOX family, ARDBOX GPRS family, ARDBOX WiFi/BT family, M-Duino family, M-Duino GPRS family, M-Duino WiFi/BT family.

Online help

More info

v
Close
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6. Click install (selecting the latest version).

Following these steps, you will be able to see now the Industrial Shields Boards:

© sketch_jul09a | Arduino 18.13 - 8 X
File Edit Sketch Tools Help

Auto Format

QulsT
Aschive Sketch
cketch_juloga|  Fix Encoding & Reload

Manage Libraries. Curteshiftel -
Serial Monitor CuteShifteM
Serial Plotter Ctri+Shift+L

WIFi101 / WIFININA Firmware Updater

o4 Board: *Arduino Uno* 4 Boards Manager
1 Arduino AVR Baards
Get Board Info Industrial Shields boards 3 Ardbox family
Programmer: "AVRISP mkll® > :"’““ D;‘: ':"‘"V
8um Bootioader e I

Ardbox WIFI/BT family
Ardbox LoRa family
M-Duino family

M-Duino GPRS family
M-Duino LoRa family
M-Duino WiFi/BT family

Once it is selected the family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ sketch_jul10a | Arduino 1.8.13

- o ®
File Edit Sketch Tools Help

Auto Format

culsT
Archive Sketch
shetch julios|  FixEncoding & Reload

()| Manage Libraries. CtrisShifts] =
Serial Monitor Car=Shift+M
Serial Plotter Curl=Shift+L

WIFI101 / WiFININA Firmware Updater

0 Board: “M-Duino LoRa family” >
¥7° Model: "M-Duino 42+ LoRa™ I M-Duino 19R+ LoRa
t M-Duino 21+ LoRa
Get Board Info M-Duino 38AR« Lofla
M-Duino 38R+ LoRa
Pragrammer B 1t Duinc 42+ Lofa

m Boatioader
Bum Boatioader M-Duina S0RRA+ LoRa

M-Duing 53ARR+ LoRa
M-Duino 544RA+ LoRa
M-Duina STAAR+ LoRa
M-Duino 57R+ LoRa
M-Duino 58+ LoRa

Furthermore there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino 42 1/0s PLUS uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino LoRa Family

© sketch_jul10a | Arduino 18.13
File Edit Sketch Tools Help

Auto Format Curl+T
Archive Sketch
Fix Encoding & Reload
o Manage Libraries. Ctrloshiftel =
Serial Monitor Curi+Shift+M
Serial Plotter Ceri+ShifteL

WIFi101 / WIFININA Firmware Updater

o Board: "M-Duino LoRa family” | Boards Manager.
Model: *M-Duino 58+ LoRa" 3 Arduino AVR Boards
Industrial Shieids boards Ardbox family
Get Board Info Ardbox DALI family
Programmer Ardbox GPRS family

Bum Boatioader Ardbox WIFI/BT family
Ardbox LoRa family
M-Duino family
M-Duino DALI family
M-Duino GPRS family

[®' M-Duino LoRa family
M-Duino WiFi/BT family
Spartan family

- Select the correct M-Duino Board (M-Duino 42+ LoRa).

© sketch jul10a | Arduino 18.13
File Edit Sketch Tools Help

Auto Format culsT
Archive Sketch
Fix Encoding & Reload

(1|  Manage Libraries.. CtrisShifts] -

Serial Monitor Carl=Shift+M
Serial Plotter Curl=Shift+L

- =] %

WIFI101 / WiFININA Firmware Updater

Board: “M-Duino LoRa family” >

T U7 Madel: "M-Duino 42+ LoRa® 3 M-Duinc 19R= LoRs
M-Duino 21+ Loka

Get Board Info

Pragrammer
Bum Bootioader

M-Duing S4ARA+ LoRa
M-Duino STAAR+ LoRa
M-Duina 57R+ LoRa
M-Duino 58+ LoRa
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- Select correct port.

@ sketch mar16a | Arduino 130 - 8 x
File Eit Sketch Tool

. at culeT
shetch marls Fix Encading & Reload

Serial Monitor CufeShittah
Senial Plotter Cul+ShiftsL

VAR 101 Finmware Updater

Boaret "Ar

o family”
Inchsstrial Shields: “Ardbox Analog™ B

port i senal port

Get Bowd Info COMI3 (Aschino Leonardo)

Programmer: “Archano as ISP
Bun Bootoader
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6 How to connect PLC to power supply

Rev. 0: 26-08-2020

- M-Duino 42 1/Os PLUS PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

|:Z"J‘1.' ER SUP PLTl

Gow |

|—1I 24Voe |

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,
the power supply is certified according to UL.

| I

¥

T

TEBE |

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 M-Duino 42 1/0s PLUS Pinout

7.1

A Zone connection

Base
(common unit)
A Zone
5 £
S o
28| ¢ g
S S 5 S
25| T 5
=0 < o
AREF | AREF Arduino PIN
IOREF2 |IOREF Arduino PIN
IOREF1 2 Arduino PIN
7vdc IOREF -
GND 1 GND
3.3vdc | 7vdc Arduino PIN
GND GND GND
5vdc  [3.3Vdc -
GND GND GND
SCL 5vdc 12C/SS
SDA GND 12C/SS
RX0 21 RX0/SS
TXO0 20 TX0/SS
RX1 1 RX1/SS
TX1 0 TX1/SS
X 19 RX2(serial 2)
RX 18 TX2(serial 2)
Z- 16 RS485
Y+ 17 RS485
B- - RS485
A+ - RS485
PIN3 - Arduino Pin
50 SO - SPI
518l 3 SPI
52 SCK 50 SPI
Reset 51 SPI
Vin5 52 5V
NC - Not Connected
GND Vin5 Gnd
GND - Gnd
24Vdc - Power Supply

Rev. 0: 26-08-2020

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

Communication Pins

Power supply connectors
(24Vdc — GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of

any device.

—

m
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Rev. 0: 26-08-2020

d ] ‘l’
. &8 zZs,
RNIES T A > -
B i2 CE g e
§ < “peser [ UsBB Program | £ R
E5 RTC Banery (CB#D) *uSD Socket[J
Ethernet Arduino / Power
Connector Reset button

USB programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)
I
B Zone
- Ang.ug‘
= £ 0 to 10Vdc
e g a Digital:
5 GCJ e _5 5 to 24Vdc
D, c = ° o
S o ° c Digital
(@] < I 5 to 24Vdc
10.12 59 An igi w0 —i—
) alog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(-)I0.6/INT1 - GND 10.6
10.6/INT1t 3 Interrupt 1 In
NC - Not Connected
NC - Not Connected
(-)I0.4 = GND 10.4
10.4 26 Digital Input
(-)10.3 = GND 10.3
10.3 25 Digital Input
(-)I0.2 = GND 10.2
10.2 24 Digital Input
()01 > GND 10.1
10.1 23 Digital Input
(-)10.0 = GND 10.0
10.0 22 Digital Input
Top Zone

Led indicator |/Os state

B Zone
28| = c
>3 o S
Qc e ©
s c B c
o > >
o = I
<
GND GND GND
A0.71 6 Analog Out
A0.61 5 Analog Out
A0.5! 4 Analog Out
Q/Vvdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
QO0.7% 6 Digital/PWM Out
Q0.6 5 Digital/PWM Out
QO0.51 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out

OFF o

NC NC
AD7 Q0T
ADE Q06

ADS Q05
W

L Analog:
0 to 10Vdc

Rev. 0: 26-08-20

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

1 See section 8 to select suitable switch configuration for enable these connections.
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7.3  CZone (Analog Shield)
C Zone
oo £
c = a
=2 g s
Qc = ©
=9 S =
O < I
11.12 65 Analog/ Digital In
11.11 64 Analog/ Digital In
11.10 63 Analog/ Digital In
11.9 62 Analog/ Digital In
11.8 61 Analog/ Digital In
11.7 60 Analog/ Digital In
(-)I1.6/INT1 - GND I1.6
11.6/INT11 19 Interrupt 1 In
(-)IL.5/INTO - GND I1.5
11.5/INTO? 18 Interrupt O In
(-)11.4 - GND 11.4
11.4 31 Digital Input
()3 > GND 11.3
11.3 30 Digital Input
(-)11.2 - GND 11.2
11.2 29 Digital Input
(-)11.1 - GND 11.1
11.1 28 Digital Input
(-)11.0 - GND I1.0
11.0 27 Digital Input

Analog
0 to 10Vdc
Digital
S to 24Vdc

Led indicator I/Os state e
A7 QL7
A6 OL6
ALS QLS
L 13 N
C Zone
2s £ c
59 o S
Qc e 3]
= ] 5
o = T
<
GND GND GND
Al.7 7 Analog Out
Al.6! 9 Analog Out
Al1l.5! 8 Analog Out
Q/Vvdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
Q1.7% 7 Digital/PWM Out
Ql.6t 9 Digital/PWM Out
Q1.5t 8 Digital/PWM Out
Q1.4 45 Digital Out
Q1.3 44 Digital Out
Q1.2 43 Digital Out H
Q1.1 42 Digital Out
Q1.0 41 Digital Out

Rev. 0: 26-08-2020

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for

Digital/PWM Outputs (isolated)

PWM/Digital Outputs

See section 8 to select suitable switch configuration for enable these connections.
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8 Switch Configuration

8.1 A Zone: Communications

Switch
ON OFF
CZONE
RX1/11.6 NC RX1
TX1/11.5 NC TX1
B ZONE
Pin 3/10.6 0.6 Pin 3
LoRa/10.5 NC LoRa
uSD & RS-485
D53(SD) NC SD
FD RS-485 HD HD FD
- QOFF OM
SCL /7 MC
' SDA/NC
° Rx1/116
Tx1/11.5
Pin3/10.6
LoRa / NC
SD /NC
FD RS485 HD

OFF On

Rev. 0: 26-08-2020

4. SCL/NC: Always at OFF Position! Switch has to be OFF position to enable SCL, never ON

because in this position is NC (Not Connected).

3. SDA/NC: Always at OFF Position! Enable SDA, never ON because in this position is NC (Not

Connected).

2. RX1/11.6: Choosing between RX1 or the input 11.6. If this switch is ON, it enables the 11.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.

1. TX1/11.5: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the 11.5
input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5.

4. Pin 3/10.6: Choosing between Pin 3 or the input 10.6. If this switch is ON, it enables the 10.6
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.6.
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3. LoRa/NC: Always at OFF Position! Switch has to be OFF position to enable the LoRa
Communication, never ON because in this position is NC (Not Connected).

2. D53 (SD): Always at OFF Position! Switch has to be OFF position to enable the Chip Select of
the microSD card, never ON because in this position is NC (Not Connected).

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables
HD.

OFF ON
LEFT ZONE
SWITCH ON OFF NC NC
NC - - NC NC
NC - - RTC
RTC RTC - RTC
RTC RTC -

1. RTC SDA: This switch enables the communication to communicate with the RTC using
I2C. Having this switch in ON mode it actives this communication, whereas if it is in
OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC using
I2C. Having this switch in ON mode it actives this communication, whereas if it is in

OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything; it doesn’t matter if itis in
ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything; it doesn’t matter if it is in
ON mode or OFF mode.
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8.2 B & C Zone Swithces

B ZONE CZONE
SWITCH ON | OFF SWITCH ON | OFF
NC - - NC - -
Q0.7 Q0.7 | A0.7 Ql.7 Ql.7 | A1.7
Q0.6 Q0.6 | A0.6 Q1.6 Ql.6 | Al1.6
Q0.5 Q0.5 | A0.5 Q1.5 Ql.5 | A1.5

K NC N NC
23| Qo7 22| Q17
SZ| Qu6 SZ| Q16
| Q0.5 |l Q15
[oN®] (e N®)]

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF,
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.
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9 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as |/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protect as the normal inputs. These
pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
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must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3 Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. If the switch configuration is in OFF
position the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can
work as digital, either input or output.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.4  SPI- MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.5 Pin 3

This pin is only referred to the input 10.6. If the switch configuration is in OFF position the Pin 3
will be available.

This pin is not stablished with a pull-up or a pull-down configuration. The state of this pin is
unknown. If this pin must be used, it requires a pull-up or a pull-down configuration. The
Arduino board allows the pin to be set in a pull-up configuration. If not, it must be stablished
an external pull-up or pull-down circuit in order to correctly work with this pin.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 12C

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If itis meant to work them as a GPIO at 5V, it has to be considered that they are pull-up inputs.

Switth | ON | OFF
SCL/NC NC sCL
SDA/NC NC SDA
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To enable 12C the switches SCL/NC & SDA/NC must be set to OFF mode. In this mode the
inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.

10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 5158l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin3 21/20/1/0/19/18/15/14/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch
ON | OFF
C ZONE
RX1/11.6 11.6 RX1
TX1/11.5 11.5 X1

If the switches RX1/11.6(11.1) & TX1/11.5(11.0) are in OFF mode, the RX1/TX1 will be enabled. In
order to use TTL3 these switches must be in OFF mode.
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10.6 LoRa

M-Duino LoRa port controller is based on RFM95C. In the M-Duino, RFM95C controller
communicates to the Mega board via SPI bus (Reset is Arduino Mega pin 2, SS is Arduino Mega
pin 12, interruption is Arduino Mega pin 13).

Also, there are some examples of programming in File -> Examples -> LoRa.

© sketch_jul10a | Arduino 1.8.13 - a x
File| Edit Sketch Toals Help

New Cri+N

Open.. 0

‘Open Recent >
>
>

Sketchbaok

Examples

Close cr=W
Save [
SaveAs.  Cl+Shiftss

08Stings
09USB
10.5tarterKit_BasicKit
1 ArduinolsP

Page Setup  CtrlShiftsP

Print culp ny board
Adafruit Circuit Playground
Preferences  Ctrl+Comma Bridge

quit cuieq

Temboo
RETIRED

Arduing DALI library

EEPROM

Ethernet

Ethemet2

GPRS >

LoRa 3 Receive
RadioHead 3 send
RS-232
R5-485
RTC
SoftwareSeria

10.7 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).

10.8 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
EE - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC : Arduino will not communicate with the RTC.
RTC SDA RTC -
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I2C (SCL, SDA pins) must be enabled in order to

Switch

ON OFF communicate with the RTC. See section 11 12C to
SCL/NC NC SCL enable it.
SDA/NC NC SDA

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.9 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): This switch must be OFF to enable the Chip Select of the microSD socket. If this
switch is ON, it is NC (Not Connected).

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.
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11 Instructions for interconnection between Industrial Shields
controllers

11.1 RS-232 Communication:

- M-Duino 421/0s * Another Industrial
' PLUS " Shields PLC |

KRFC-G Ferrite (4 Loops]
Tx (5“ TTx

SHIELDED CABLE

Ferrite KITA Ferrite KITA
GND

SO | ~
12/24V | @O%( 12/24V
/ \ J \

ol B C [ 1 )

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

M-Duino 42 I/0s (\’._‘Another Industrial
PLUS " | ShieldsPLC |

KRFC-6 Ferrite (4 Loops)
A =~ =A
RS-485 B ... B RS-485
SHIELDED CABLE

Ferrite KITA Ferrite KITA
GND | | i GND
12124V m@@ | JC @9: : : : 12/24V
/ \ J \

< - > [« [ A b

11.2.2 Full Duplex

— — - ——

M-Duino 42 1/0s ‘:\Another Industrial
PLUS " Shields PLC |

KRFC-6 Ferrites (4 Loops)

5 BT o
B ¥ +B
RS-485 RS-485
Y -y
z 1Y z
Ferrite KITA o AER CARI E Ferrite KITA
GND SHIELDED CABLES |

| ¥ GND
12124V EOC)@ | W 12/24V
/ A ] \

< | e J A >
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11.3 Ethernet

KRFC-6 Femte

"":i{BFi}jjr::;rjjj, ,
I Ethernet . f—

M-Duino 42 1/Os V_Another Industrial
PLUS Shields PLC

I}
i

Ferrite KITA Ferrite KITA

GND ~_— . GND
12124V X)OQ)@ W 12/24V

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

Rev. 0: 26-08-2020

(,,Wu ISOLATED INPUT \

&
&

GND
Sharzev

‘] (100

o/,c;jﬁ.ﬁ

SHIELDED CABLE

Ferrite KITA

@l

i

SHIELDED CABLE

/ Dowrdoad e MDUND LAYOUT:
From®

< e N

S T

Ferrite KITA

o

0 POWER

B oomaw

SHIELDED CABLE .|| Duumlon s MOURO LAVOUT:
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SHIELDED CABLE
2124V o

Ferrite KITA
0

S wi—

Rev. 0: 26-08-2020

0.7

SHIELDED CABLE Fromt wamdvesAS o \
< mt U

0-10v

S, |

Ferrite KITA

\J

224V

0.7

SHIELDED CABLE L}:“w \
S—"
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SHIELDED CABLE

0-10v

@ 51224V
GND
Ferrite KITA
GND A
12024V

Ferrite KITA

0.7

Rev. 0: 26-08-2020

SHIELDED CABLE Downioed e MOUINO LAYOUT!
i From: www.industrisishisids. com \

SR

B owemuour

Qo0 <)

SHIELDED CABLE

£\

L

SM2r24v
oA

VOUT = @/ Vde

SHIELDED CABLEf Pty drussentt felipocd \_

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT/ ®
GND VOUT = 0/ Vde
m{ﬁ

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

* Sow the swilch
configutarion (ON)
Qivde H- 51224V
COM {-) { GND .&
J ALWAYS
JU1 CONNECTED
Ferrite KITA Q0.8 ® SHIELDED CABLE
f: POWER VOUT = Q/ Vide
"'L; I DIGITALFWA OUT

SHIELDED Cﬁﬂlﬂﬂ L e
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* Soo the switch
configutarion (ON)
Q/Vde
COM (=) gﬁw
Jn CONNECTED
Ferrite KITA 05 @
B Mﬁ] VOUT = Q/ Vide
224V DAGETALPWA OUT
SHIELDED ASL;/—ELT%
\J y
SHIELDED CABLE
—
(/_:uuoeou-rpur )
\I * Analog Outs no led r’f
indlicator
S B * See the switch
1[0 g Olos configutarion (OFF)
M.ii[{;u GND =
@3/0 g O| 02 AO5 E‘—” “'W)
g
ME SHIELDED CABLE
NCiOD O WI!/
Ferrite KITA —ia o
GND
= 9) |} power
20N | 8 ANALOG OUT
SHIELDED CABLE Dowibad o MOMOLAOUT: |
/ e
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension M-Duino 42 1/0Os PLUS:

0
-
8=
<t
- DIN Rail mounting
Profilato o cappello TH 35-7,5 Prafilato o cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
155,
RO8
RO
]
=
+ L_
SRS 1=004
Sezione A/ Section A .
o~ 2,2 min. finoa / To 2,5 max
S| e
7l
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Mecconiche  Reigoreo o tuzioneolo srenomente  ASTM D638 MPo 68 Mechanical fest Resiionce o tesile stess f yield ASTMDS38 MRy 68
Redisoreo o tuzionea nttw ISTIDB3E  MPo 48 Tonglostength ASTMD638 MR %
Allngomento o totin K088 9 i o ASTMD638 % 9
Mool in fesione STADIN _ MPo 2894 Pleing modules ASTADTS0 MR 7894
Pova Iz0d con intoglio 150180/14 X/ 55 rod test noiched 1018014 X' 55
Termiche Temp di nmmolinento Viat, medoB AT DIS2S  °C 114 Thermal fest Vit sodtening tomperctuee method B ASTMDIS2S 114
Tomperoun Ricto 1 81 My K068 °C 91 Rebeting temperatue 1,81 WPg ASTMD848  °C 9
Fisiche Peso gadfin K092 géamd n Physical test  Spaciic gy ASTHDT®? _ géand 12
Riti nello stompo STADSS % 0408 Mould hiinkage ASTMDSS % 0408
Mol Flow Index 260°C - 98N KSTNDIZE  o/10° 111 Melt Flow Ines 260°C - 98N ASTMDIZ38 10’ 11
Comportamento Avbesinguerza (i di pesoe) [I2) - V-0(08) Flome fest Self atinguishr (thidness in mm) L4 - V0(08)
allo fiomma _Fib Incadescen 37 mm 69521 °C 960 Inndestents thiepd 32 mm IEC89521 960
Italtronic si riserva il diritto di modificare il moteriole con cui realizzo i propri prodotti Italtronic con operate ony change of the materials without being obliged to forewam.
senzo obbligo di preawviso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 42 |I/Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 42 1/0Os PLUS. When configuring the layout of the M-Duino 42 I/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high-
energy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring M-Duino 42 1/Os PLUS. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of
the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid-filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Revision Number Date Changes

0 27/08/2020 First implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitdés de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 0: 26-08-2020
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